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Liquid Printing
Liquid printing enables you to embed liquid within in a printed part. Printing with PolyJet®
cleanser material together with other model materials, allows you to achieve
hermetically-sealed voids that contain liquids in a single print. The cleanser material can be a
feature in a printed part or it can be removed after printing. These capabilities are suitable for
applications such as printable hydraulics and fluidics.
Figure 1: Model with cleanser by Robert MacCurdy | Printable Hydraulics | MIT CSAIL

To achieve optimum results when printing parts with cleanser, follow these recommendations:
Wear protective gloves when handling part printed with cleanser.
•

Parts with voids that contain cleanser should be designed as an enclosed assembly, so
that the enclosure is sealed and there is no leakage of cleanser.
If the part was not designed as a separate enclosure and the accuracy of the part’s
dimensions are not critical, you can quickly add an enclosure to the part in GrabCAD Print
by assigning a Vero coating to the part.

•

Minimal wall thickness of void containing the liquid should be at least 1 mm.

•

The size of the void that is filled with liquid should not exceed 20 x 20 x 20 mm.

•

Print in High Mix mode only. Liquid printing is not available in other printing modes.

•

Before every print job:
•

Run the Cleaning wizard and clean the print head, UV lamp glass and roller.

•

Clean the roller waste collector.

For detailed procedure, refer to the printer User Guide available on the Support Center.
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•

Part orientation affects model quality. Consider this when orienting the part on the build
tray.

•

Remove the Support material in a waterjet using low water pressure.
Figure 2: Tray Settings dialog box—Cleanser and High Mix selected

Figure 3: Model Settings dialog box—Cleanser option
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The following table list clearances that can be used when designing parts for 3D printing with
liquid and non-liquid materials.
Table 1: Clearances for printing with liquid | by Robert MacCurdy
Feature

Clearance

Separation (minimum along X/Y-axis)

0.4 mm

Separation (minimum along Z-axis)

0.2 mm

Feature thickness (minimum along X/Y-axis)

0.325 mm

Feature thickness (minimum along Z-axis)

0.2 mm

Feature growth (perpendicular to Y/Z-axis)

0.150 mm

Feature growth (perpendicular to X-axis)

0.2 mm

Solid-solid clearance at rotational joint

0.3 mm

Solid-over-liquid support thickness

0.2 mm

Solid-next-to-liquid support thickness

0.5 mm

Largest segment of liquid (distance in X or Y)

20 mm

Recommended width of support “pillars”
inserted to connect model layers otherwise

0.5 mm

isolated by liquid (X/Y-axis)
Recommended solid feature thickness when
adjacent to largest liquid segment (X/Y-axis)

2.11 mm

Important: The clearances in the table have not been test in Stratasys® labs.
The table above was taken from MacCurdy, R.; Katzschmann, R.; Kim, Y. & Rus,
D. “Printable Hydraulics: A Method for Fabricating Robots by 3D Co-Printing
Solids and Liquids”, 2016.
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Air Printing
Air Printing enables you to use air as a virtual material when printing parts. The Air Printing
feature in GrabCAD Print™ allows you to create air-filled voids within parts for embedding
electronics and creating smart inserts. In addition, air printing is useful for controlling the part
weight, textures and surface finish.
Figure 4: Model with air voids by Robert MacCurdy | Printable Hydraulics | MIT CSAIL

When designing voids that are filled with air, you need to ensure that the top of void is printed in
such a way so that it is sealed. To create a sealed air void, you need to design the tip of the
void with an angle of between 7 to 9 degrees.
The degree of the angle needed to seal the tip of the void may differ for different
printing materials.
Figure 5: Air voids with tips that are between 7 to 9 degrees
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Figure 6: Sample of air voids with tips

Figure 7: Model Setting dialog box—Air Void selected
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In addition, it is possible to print a combination of both liquid and air in a sealed void.
Figure 8: Model Setting dialog box—Cleanser and air digital material selected
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Pause Print
Pause Print enables you to pause and resume printing at a specific slice or height. With the
Pause Print feature in GrabCAD Print, you can plan several pauses during the print job. During
these pauses, you can open the printer cover and insert electronics, parts, or inject materials.
Figure 9: Planning pauses screen

To ensure that the printer pauses at the correct height, you need to measure the part’s height.
You can do this using the measuring tools your CAD software.
When measuring the height:
•

Verify that the part is in its print orientation.

•

Measure the distance from the bottom of the part until the end of the air void enclosure.
(without the pedestal), and enter the measurement in GrabCAD Print. Repeat this
measurement for each air void enclosure.
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Support Visualization
Support visualization enables you to see in GrabCAD Print where the support material will be
printed around the part. This feature helps indicate whether the surface finish will be matte or
glossy.
Figure 10: Support material surrounding the part
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Tray Height Adjustment (Z-Start)
When printing directly on substrates, such as glass and wood, you need to re-adjust the build
tray’s start position (height) and its distance from the roller. This ensures that the print block
does not collide with the substrate during printing, and that the 3D print is printed accurately on
the substrate.
The procedure described below recommends printing a contour of the substrate to assist you
in accurately placing the substrate on the build tray, and to ensure that the substrate remains
stable and in place while printing on its top surface. Depending on your needs and workflow,
you may need to employ a different method than the one described here.
Adjusting the tray height has the following general steps:
1. “Preparing a Printed Contour of the Substrate”
2. “Adjusting the Tray Height Start Position” (page 15)

Preparing a Printed Contour of the Substrate
1. In your CAD software design the following parts:
•

A model of the substrate

•

A contour of the substrate model
The contour can be the same height at the substrate model or a little lower.

•

The 3D print you wish to print on the surface of the substrate
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2. Import the STLs you designed into GrabCAD Print as an assembly.
Figure 11: STL files imported as an assembly (sample)

3. Hide the substrate and part STLs, and leave only the contour STL visible.
Figure 12: The contour is visible, all other STLs are hidden
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4. Print the contour STL only.
Figure 13: Printed contour (sample)

Adjusting the Tray Height Start Position
1. Measure and record the height of the substrate (in millimeters) on which you are planning
to print.
If the surface of the substrate is not flat, make sure that you measure the distance
between the lowest to the highest peaks of the substrate.
2. Prepare two transparency sheets (supplied in the Start-Up Kit).
3. From the Options menu, select Motors Control.
Figure 14: Motors Control in the Option menu
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4. Select the Enable check box.
Figure 15: Motors Control screen enabled

5. When the following message appears, close the printer cover.
Figure 16: Close the printer cover message

6. In the Units field, select Millimeters.
Figure 17: Motors Control screen enabled
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7. Click Home.
The print block moves to Home position.
From the Home position (0), positive values move the tray downward and
negative value move the tray upward.
Figure 18: Clicking Home

8. Click Goto.
The build tray moves to the saved tray height start position.
Figure 19: Clicking Goto
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9. In the Move field, enter the measured height (step 1) in millimeters. Make sure that the
Absolute value check box is clear.
Figure 20: Entering the height in the Move field

10. Click Move to lower the build tray. The build tray moves downward.
11. Click Unlock Door and open the printer cover.
Figure 21: Clicking Unlock Door
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The Motor Control screen is disabled.
Figure 22: Motor Control screen disabled when printer cover is open

Important:
Unlocking the printer cover disables the Motors Control screen and the current
tray position is not saved. In the next attempts, make sure that you increment the
number of millimeters you enter in the Move field according to the required height
adjustment. For example, if you entered 30 millimeters in the first attempt and the
tray needs to be lowered by an additional 5 millimeters, in your next attempt, enter
35 in the Move field and try again.
12. Place the substrate within the printed contour.
Figure 23: Substrate placed within the printed contour (sample)
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13. Using one transparency, slowly and carefully move the print block manually over the
substrate. While moving the print block, hold the transparency sheet between the substrate
and the roller (under the print block).

Caution:
Moving the print block manually induces an electrical current that can damage
components. Move the print block slowly to minimize the current and reduce the risk
of damage.
Figure 24: Testing the friction with the roller (with sample substrate)
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14. Slide the transparency sheet back and forth between the roller and the substrate (or the
highest point on the substrate if it is not flat).
The transparency sheet should slide in and out from under the print block and you should
feel some friction between the roller and the transparency sheet.

Caution:
Too much friction between the roller and the substrate may damage the roller. Make
sure that the roller only slightly contacts the transparency sheet.
15. If there is some slight friction with one transparency sheet between the roller and the
substrate, repeat step 14 with two transparency sheets. If two transparency sheets cannot
pass between the substrate and the roller, this indicates that the distance between the print
block and the substrate is accurate. Continue with Step 17.
16. If there is no friction or too much friction when using one transparency sheet, continue as
follows:
a. Slowly and carefully move the print block to the left rear corner of the printer.

Caution:
Moving the print block manually induces an electrical current that can damage
components. Move the print block slowly to minimize the current and reduce the risk
of damage.
b. Remove the transparency sheets and tools from the printer.
c. Close the printer cover and click Lock Door.
d. Select the Enable check box.
e. Click Home and click Goto.
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f.

Click Move to lower the tray again to the measured height from step 1.

Caution:
Moving the print block manually induces an electrical current that can damage
components. Move the print block slowly to minimize the current and reduce the risk
of damage.
g. Click Unlock Door and open the printer cover.
17. Repeat the process from step 13 and adjust the height of the tray until there is slight friction
with the tray in all relevant areas on the substrate.
18. When there is slight friction between the roller and the surface of the substrate, type the
value from the Position field into the Goto field, and click Save.
Figure 25: Copying the tray height value

19. Click Close.
20. Send the print job and print on the surface of the substrate.

© Copyright 2021 Stratasys. All rights reserved.

Page 22

www.stratasys.com
_____
c-support@stratasys.com
Copyright © 2021 Stratasys Ltd. All rights reserved.
DOC-18131 Rev. A

THE 3D PRINTING SOLUTIONS COMPANY

Guide to
Voxel Printing
with
GrabCAD Print™
Stratasys J5™ / J7™ / J8™ 3D Printers

Voxel Printing Guide

Copyright
Copyright © 2017-2021 Stratasys Ltd. All rights reserved.
No part of this document may be photocopied, reproduced, or translated into any human or computer
language in any form, nor stored in a database or retrieval system, without prior permission in writing from
Stratasys. This document may be printed for internal use only. All copies shall contain a full copy of this
copyright notice.

Trademark Acknowledgments
Stratasys, Objet, PolyJet, GrabCAD, GrabCAD Print, J7, J8, J5 and VeroMagenta are trademarks of Stratasys
and/or subsidiaries or affiliates and may be registered in certain jurisdictions. All other product names and
trademarks cited in this book are the property of their respective owners.

Liability
Stratasys shall not be liable for errors contained herein or for incidental or consequential damages in
connection with the furnishing, performance, or use of this material. Stratasys makes no warranty of any kind
with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness
for a particular purpose. It is the responsibility of the system owner/material buyer to determine that Stratasys
material is safe, lawful, and technically suitable for the intended application as well as identify the proper
disposal (or recycling) method consistent with local environmental regulations. Except as provided in
Stratasys' standard conditions of sale, Stratasys shall not be responsible for any loss resulting from any use of
its products described herein.

Disclaimer
Customer acknowledges the contents of this document and that Stratasys parts, materials, and supplies are
subject to its standard terms and conditions, available on
http://www.stratasys.com/legal/terms-and-conditions-of-sale, which are incorporated herein by reference.
The specifications and/or information on which this document is based are subject to change without notice.

Technical Service
If problems arise with this system, please contact Stratasys Customer Support. Contact information is
available from the Stratasys website at:
http://www.stratasys.com/customer-support/contact-customer-support.
For comments on this guide: c-support@stratasys.com
June 2021
www.stratasys.com

© Copyright 2017-2021 Stratasys. All rights reserved.

Page 2

Voxel Printing Guide

Contents
Overview..................................................................................4
Slice Preparation Guidelines ...................................................5
Generating a GrabCAD Voxel File from PNGs........................6
Creating a GrabCAD Voxel File from BMPs ............................10
Preparing a Voxel Configuration Text File for BMPs....................................... 10
Generating a GrabCAD Voxel File from BMPs............................................... 16

Printing a Voxel Print Job ........................................................19

© Copyright 2017-2021 Stratasys. All rights reserved.

Page 3

Voxel Printing Guide

Overview
Voxel printing enables the fabrication of many different parts with complex material distribution, such as a
gradient or a sophisticated pattern.
In a program, such as Matlab, you slice the model and generate a stack of BMPs or PNGs. Each slice
contains the voxel information.
After processing these files in the Stratasys Voxel Print Utility, you import the generated GrabCAD voxel file
(*.gcvf file) into GrabCAD Print for printing.
This guide provides instructions for voxel printing with GrabCAD Print on Stratasys J7, J8 and J5 series 3D
printers.

Important:
Verify that the computer workstation you use to send the information to the printer has the minimum
requirements, as described in the relevant Site Preparation Guide.

Revision History
Translations of this guide are updated periodically. If you are consuming a translated version,
please check the English version for the latest revision and list of updates.

Revision
G

Release date
June 2021

Description
•

Replaced J55 with J5 series throughout the guide.

•

Removed the confidentiality statement from the
guide.
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Slice Preparation Guidelines
When preparing the slices (BMPs or PNGs files), consider the following guidelines:
•

The number of slices for each material must be identical.

•

Make sure that you prepared one BMP/PNG for each slice. If a certain material is not used in a specific
slice, create an empty BMP/PNG file (blank) for it.

•

It is recommended that the layer thickness of the slices you prepare match the printer layer thickness.
Printer layer thickness is, as follows:
•

J5 series—0.01875 mm

•

J7 and J8 series—
•

0.014 mm (in High Quality mode)

•

0.027 mm (in High Speed & High Mix modes)

When printing the slices, if the slice thickness does not match the printer layer thickness, the printer
compensates for the difference. This may include repeating or skipping of slices. For example, if you set
the slice thickness to 0.0135 mm, and your printing mode is High Mix, the printer prints each image twice
to reach the desired thickness of 0.027 mm.
•

When assigning colors to your model, it is recommended that you use the RGB values of the PolyJet base
materials. Below is the list of RGB values of PolyJet base materials.
Color

Red

Blue

Green

Cyan

0

89

158

Magenta

161

35

99

Yellow

213

178

0

Black

30

30

30

White

220

222

216
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Generating a GrabCAD Voxel File from PNGs
After preparing the PNG file, you need to process it in the Voxel Print Utility in GrabCAD Print. This utility
generates a GrabCAD voxel file (*.gcvf file) that you import into GrabCAD Print for printing.
The files size of a single *.gcvf file cannot exceed 2 GB.

To generate GrabCAD voxel files from PNG files:
1. Open GrabCAD Print.
2. From the Apps menu, select Launch Voxel Print Utility.

The Voxel Print Utility opens.
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Important: Slicing Parameters for J5-Series Printers
•

Slice resolution = 300 x 300 DPI

•

Slice thickness = 0.01875 mm

3. From the Tools menu, select Insert PNG.

4. In the Slice file prefix field, enter a prefix for the image files, such as ‘slice_’.
This prefix is assigned to all image files.

5. Click Select and navigate to the folder that contains the PNG files.

6. Select the folder where the files PNG are located.
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The location of the files, the path to the GCVF file, and all relevant slice information appear in the screen.

7. Click Next.
A progress bar shows the progress of the *.gcvf file generation.
The file generation can take a few minutes, depending on the size of the file.
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When the *.gcvf file generation is complete, the Material Mapping screen appears. The colors on the right
side are the base colors that the Voxel Print Utility identified in the PNG files. To ensure color accuracy
when printing the model on the PolyJet 3D printer, you need to match each of the colors on the right with
a suitable PolyJet Model material (left side). For example, the blue color on the right side could be
mapped to VeroBlue or VeroCyan.

Base colors that the
utility extracted from
the PNG files.

8. In the Materials column, select each PolyJet Model material you want to use based on the color shown on
the right side of the screen.
Before printing, make sure that the Model materials that you assigned are loaded in the material
cabinet.
9. Click Finish.The following message appears.
10. When the following message appears, click OK.

11. Close the Voxel Printing Utility.
12. To print the voxel file, continue with “Printing a Voxel Print Job” on page 19.
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Creating a GrabCAD Voxel File from BMPs
To generate a GrabCAD voxel file from a BMP file, you first need to create a voxel configuration file.

Preparing a Voxel Configuration Text File for BMPs
When printing BMP slices, you need to create a voxel configuration text file. You do this in a text editor, such
as Notepad.
Below is a sample of a voxel configuration text file.

Important:
•

The bitmap files need to be 1-bit (binary) BMP format.
•

BMP LUT 0 for voxels in which the current material is not printed.

•

BMP LUT 1 for voxels in which the current material is printed.

•

The BMP files should be named by their materials. The exact material name does not matter,
since the exact material names are specified in the text file.

•

BMP files are not required for the Support material assignment. GrabCAD Print calculates where
Support material is needed.

•

Save the BMP files and the voxel configuration text file on the host computer, not on the printer
computer.

•

The number of resins and materials listed in the text file depends on your printer. For example
for J5 series, you will have 5 resins and materials listed.
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IMPORTANT: Do not modify the format of this text file.
Follow the instructions in this section to create the voxel configuration text file accurately.

To create a voxel configuration text file:
1. In the text file, list the parameters as follows:
•

Build section—
Parameters in File

Definition / Instruction
This is a section header for the following
parameters.

[Build]

Do not add a semi colon (;) at the end of the
header.

Format version = 1;

Keep this value as ‘1’.

Build Mode = x;

Set the values to ‘3’.

Layer thickness = 0.0xx;

Set the layer thickness that you used to slice
the model (see “Slice Preparation
Guidelines” on page 5).

Number of slices = xxx;

Set the total number of slices for each
material (see Note below).
Important: GrabCAD Print crashes if this
number is not correct.

Number of Slices:
To determine the total number of slices, open the folder where the slices are located, and
check the number of the last slice. If the first slice is ‘0’, you need to add 1 to the number
of the last slice. For example, if the first slice is slice_0.png and the last slice is
slice_2124.png, enter 2125 in the field, as shown below.
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•

Resin Type section—for J5 series
Parameters in File

This is a section header for the list of
material names in the printer.

[Resin Type]

•

Definition / Instruction

Do not add a semi colon (;) at the end of the
header.

Support = FullCure705;

Set the Support material name.

Color = <Model material1 name>;

Set the name of a material loaded.

Resin2 = <Model material2 name>;

Set the name of a material loaded.

Resin3 = <Model material3 name>;

Set the name of a material loaded.

Resin4 = <Model material3 name>;

Set the name of a material loaded.

Resin5 = <Model material3 name>;

Set the name of a material loaded.

Resin Type section—for J7 and J8 series
•

In High Speed mode, where there are only 3 Model materials are used for printing:
Parameters in File

Definition / Instruction
This is a section header for the list of
material names in the printer.

[Resin Type]

Do not add a semi colon (;) at the end of the
header.

Support = FullCure705;

Set the Support material name.

Color = <Model material1 name>;

Set the name of a material loaded.

Resin2 = <Model material2 name>;

Set the name of a material loaded.

Resin3 = <Model material3 name>;

Set the name of a material loaded.
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•

In High Quality and High Mix modes, where there are 6 materials loaded:
Parameters in File

Definition / Instruction
This is a section header for the following list
of material names in the printer.

[Resin Type]

Do not add a semi colon (;) at the end of the
header.

Support = FullCure705;

Set the Support material name.

Color = <Model material1 name>;

Set the name of a material loaded.

Resin2 = <Model material2 name>;

Set the name of a material loaded.

Resin3 = <Model material3 name>;

Set the name of a material loaded.

Resin4 = <Model material4 name>;

Set the name of a material loaded.

Resin5 = <Model material5 name>;

Set the name of a material loaded.

Resin6 = <Model material6 name>;

Set the name of a material loaded.

Resin7 = <Model material6 name>;

Set the name of a material loaded. (For J8
printers only.)

Important:
•

<Model material name> represents the name of the model material loaded in the material
cabinet. The material names need to be listed exactly as they appear in the Stratasys software
(not as they appear on the cartridge).
For example, if the material name in the software is VeroMgnt, and on the cartridge it is
VeroMagenta enter VeroMgnt in the text file.

•

In the Resin Type section, make sure that you list the model materials in the order they are
loaded in the material cabinet compartments.

•

Even if the job requires only some of the model materials loaded in the material cabinet:
•

when printing in High Speed mode, list only the names of the 3 model materials you are
using for printing.

•

when printing in High Mix or High Quality mode, list the names of all 6 model materials
loaded.
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•

Materials section—for J5 series
Parameters in File

Definition / Instruction
This is a section header. In this section you
provide the paths to the bitmaps of each of
the materials (resins) in the order listed
above.

[Materials]

Do not add a semi colon (;) at the end of the
header.
Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp
Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp
Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp
Material4 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp
Material5 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp
•

Materials section—for J7 and J8 series
•

In High Speed mode, where there are only 3 materials are used for printing:
Parameters in File

[Materials]

Definition / Instruction
This is a section header. In this section you
provide the paths to the bitmaps of each of
the materials (resins) in the order listed
above.
Do not add a semi colon (;) at the end of the
header.

Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp
Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp
Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

© Copyright 2017-2021 Stratasys. All rights reserved.

Page 14

Voxel Printing Guide
•

In High Quality and High Mix modes, where there are 6 materials loaded:
Parameters in File

[Materials]

Definition / Instruction
This is a section header. In this section you
provide the paths to the bitmaps of each of
the materials (resins) in the order listed
above.
Do not add a semi colon (;) at the end of the
header.

Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp
Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp
Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp
Material4 = C:\<path to color bmp>\<material4 filename>_xxxx.bmp
Material5 = C:\<path to color bmp>\<material5 filename>_xxxx.bmp
Material6 = C:\<path to color bmp>\<material6 filename>_xxxx.bmp
Material7 = C:\<path to color bmp>\<material6 filename>_xxxx.bmp
(For J8 printers only.)
•

Make sure that the path to the BMP files correspond to the order in which the materials are
listed in the Resin Type section.
For example, if material1 is VeroCyan, the path should be to the cyan BMP files.
•

These represent the number of digits in the bitmap filenames. If you use four digits in
the bitmap filename, include four ‘x’s in the material definitions. If you use five digits in
the bitmap filename, include five ‘x’s in the material definitions.

•

The ‘x’s in the material definition must be in lower-case.

2. Save the configuration text file with a *.txt file extension.
The filename of the configuration text file will be the job name in the Manager queue.
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Generating a GrabCAD Voxel File from BMPs
After preparing the BMP file and TXT file, you need to process them in the Voxel Print Utility in GrabCAD Print.
This utility generates a GrabCAD voxel file (*.gcvf file) that you import into GrabCAD Print for printing.
The files size of a single *.gcvf file cannot exceed 2 GB.

To generate GrabCAD voxel files from BMP files:
1. Open GrabCAD Print.
2. From the Apps menu, select Launch Voxel Print Utility.

The Voxel Print Utility opens.
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Important: Slicing Parameters for J5-Series Printers
•

Slice resolution = 300 x 300 DPI

•

Slice thickness = 0.01875 mm

3. From the Tools menu, select Insert BMP.

4. In the Pff params area:
a. Click Select and navigate to the folder that contains the BMP files.
b. Select the voxel configuration text file (*.txt file) you created (see “Slice Preparation Guidelines” on
page 5).
The *.txt file is also known as the Print From File (PFF) config file.
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c. In the GCVF output file name field, enter the desired location and name of the generated *.gcvf file.
The path must contain a *.gcvf file extension, as shown in the figure below.

5. Click Next.
A progress bar shows the progress of the *.gcvf file generation.
The file generation can take a few minutes, depending on the size of the file.

When done, the following message appears.

6. Click OK to close the message.
7. Close the Voxel Printing Utility.
8. To print the voxel file, continue with “Printing a Voxel Print Job” on page 19.
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Printing a Voxel Print Job
To print a voxel print job:
1. From the File menu, select Add Models.

2. Navigate to the location of the *.gcvf file you generated, select it, and click Open.
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GrabCAD Print validates the file and loads it.
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Important:
•

During the *.gcvf file generation, an *.stl file of the model is created. GrabCAD Print uses this stl
file to display the model on the tray, as shown in the above figure. Since it is not possible to view
the colors you assigned to the model in GrabCAD Print, it is very important that you make sure
that the correct materials are loaded in the material cabinet.

•

An exclamation mark icon
appears near the filename (shown above) if the *.gcvf file
contains a material that is not loaded in the tray materials. If you do not load the required material
in the printer, the printer ignores the material assignment in the *.gcvf file, and prints the file as
an stl file using a default material.

•

Glossy surface finish is not available, only matte.

•

Grid style selection is available.

•

You can add copies of the model on the tray by right-clicking on the model and selecting
Duplicate.

•

The Scale and Orient options are not available. To change the size or the orientation of the
model, you need to generate a new *.gcvf file with the desired size and/or orientation.

•

You can use the Arrange (tray) option. Tray arrangement is performed according to the
orientation defined in the BMP/PNG files.
Do not select the Optimize check box. Currently, it does not work properly with *.gcvf files.

3. Click Print to send the file to print.
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Editing Parameters in GrabCAD Print™
This procedure describes how to edit GrabCAD Print parameters using the Parameter edit tool.

Required Tools and Materials
GrabCAD PolyJet New Parameter Editor tool

Using the Parameter Editor
To edit parameters:
1. Double-click

on your desktop.

2. In the Open Database File screen, select Client and click OK.
If GrabCAD PolyJet Job Manager is installed on your computer, or if you are
connected to a printer, a Server option appears in the Open Database File
screen.
Figure 1: Database selection

3. When the application opens, select the printer type.
Figure 2: Printer selection
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4. In the following screen, select:
•

Materials: select all of the Model materials currently loaded in the printer

•

Supports: select the Support material currently loaded in the printer

•

Print Modes: select the print modes you wish to edit.
Figure 3: Materials, Support, and print mode selection

5. Click Fetch.
Figure 4: Fetch button

The data is processed and the relevant parameters appear in the Edit Parameters tab.
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Figure 5: Parameters displayed

6. From the drop-down list in the Column filter, you can select additional columns that you can
add to the table for editing.
Figure 6: Column filter

7. Double-click in the cell you wish to edit, and change the value.
Until you save your changes, the previous parameter appears in the blue circle in
the right corner of the cell.

© Copyright 2020-2021 Stratasys. All rights

Page 3

Editing Parameters in GrabCAD Print™
Figure 7: Editing parameters

New
value
,

8. Click Save to save your changes.
9. Print a file to confirm that the changes you made were successful.
To restore the original parameters, from Options button (in the top right corner of the
Parameter Editor screen), select Restore to Factory DB Parameters.
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